The SalsaJ software

Jérôme Lucas
LERMA/ERGA
Université Pierre et Marie Curie, Paris 6

1

Documentation
●

Introduction

●

Basic Concepts

●

Installation

●

Menu Commande
❍

File

❍

Edit

❍

Image

❍

Operations

❍

Analyze

❍

Plugins

❍

Windows

●

Tools

●

Keyboard Shortcuts

Download the manual in .pdf

2

Introduction
The software developed for the EUHOU program has been designed to be a multi-platform,
multi-lingual experience for image manipulation and analysis in the classroom. Its
design enables easy implementation of new facilities and basically requires no in-situ
maintenance. For the software and each pedagogical resource, different levels of utilisation
will be implemented (i.e. middle, high schools…). The software is freely distributed. A hot-line
will be provided to the pilot school teachers

| Basic Concepts | Contents
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Basic Concepts

Windows
The "SalsaJ" window contains a menu bar (at the top of the screen on the Mac), tool bar, status bar, and a progress bar. Images, histograms, line
profile, etc. are displayed in additional windows. Measurement results are displayed in the "Results" window. Windows can be dragged around the
screen and resized. Histograms and plots are ordinary image windows that can be copied (to the internal clipboard), edited, printed and saved.

Tool Bar

The tool bar contains tools for making selections, for zooming and scrolling images, and for changing the drawing color. Click on a tool and a
description of that tool is displayed in the status bar.

Status Bar

The status bar, when the cursor is over an image, displays pixel coordinates and values.

Progress Bar
The progress bar, located to the right of the status bar, shows the progress of time-consuming operations. It will not appear if the operation requires
less then approximately one second.

Images

SalsaJ allows multiple images to be displayed on the screen at one time. The active window has its title bar highlighted. All operations will be
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performed on the active image. SalsaJ supports 8-bit, 16-bit and 32-bit (real) grayscale images and 8-bit and 32-bit color images. 8-bit images
are
represented using unsigned integers in the range 0 to 255. 16-bit images use unsigned integers (0 to 65,535) and 32-bit grayscale images use

floating-point numbers.
16-bit and 32-bit grayscale images are not directly displayable on computer monitors, which typically can show only 256 shades of gray. Therefore,
the data are mapped to 8-bits by windowing. The window defines the range of gray values that are displayed: values below the window are made
black, while values above the window are white. The window is defined by minimum and maximum values that can be modified using Image/Adjust/
Brightness/Contrast.

Stacks

SalsaJ can display multiple spatially or temporally related images in a single window. These image sets are called stacks. The images that make up a
stack are called slices. All the slices in a stack must be the same size and bit depth. A scroll bar provides the ability to move through the slices. Must
SalsaJ filters will process all the slices in a stack.

Selections

Selections are user defined areas or lines within an image. Only one selection can be active at a time. Area selections are created using the
rectangular, oval, polygonal and freehand selection tools. Area selections can be measured (Analyze/Measure), filtered, filled (Edit/Fill) or drawn (Edit/
Draw). Line selections are created using the straight, segmented and freehand line selection tools. Use Edit/Draw to draw the line in the current color.
The length of line selections can be measured using Analyze/Measure.
Selections can be moved by clicking and dragging. The status bar displays the coordinates of the upper left corner of the selection (or the bounding
rectangle for non-rectangular selections) as it is being moved. Notice that the cursor changes to an arrow when it is within the selection. To move the
contents of a rectangular selection, rather than the selection itself, Edit/Copy (c), Edit/Paste (v), and then click within the selection and drag. Use the
arrow keys to nudge selections one pixel at a time in any direction.
Rectangular selections can be resized using the handle (small box) in the lower right corner. As the selection is stretched, the width and height are
displayed in the status bar. Use the arrow keys with the alt key down to stretch rectangular or oval selections one pixel at a time.
To delete a selection, choose any of the selection tools and click outside the selection, or use Edit/Select None (shift-a). Use Edit/Restore Selection
(shift-e) to bring a selection back after having deleted it.
A selection can be transferred from one image window to another by activating the destination window and using Edit/Restore Selection. Press the tab
key to activate a series of windows in sequence.
Selections can be saved to disk using File/Save As/ROI and restored using File/Open. Multiple selections can be saved by transferring them to a blank
window, drawing each one using Edit/Draw, and saving the resulting image. To restore one of the selections, open the image and click to the left of
one of the drawn outlines with the wand tool.

File Formats
The File/Open command opens TIFF (uncompressed), GIF, JPEG, BMP and FITS images. It also opens lookup tables and selections (ROIs). In addition,
the File/Import submenu provides access to plugins for reading "raw" files, images in ASCII format, and for loading images over the network using a
URL. To import a raw file, you must know certain information about the layout, including the image size and the offset to the image data. Add support
for additional formats by downloading or writing plugins. Files can be saved in TIFF, GIF, JPEG, FITS, tab-delimited text, and raw formats.

Plugins
SalsaJ's functionality can be expanded through the use of plugins written in Java. Plugins can add support for new file formats or they can filter or
analyze images. Plugins located in SalsaJ's "plugins" folder are automatically installed in the Plugins menu.

Lookup Tables

Grayscale images are displayed using a color lookup table which describes the color to be used for each of 256 possible displayed pixel values.
Select
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alternative color palettes from the Image/Lookup Tables submenu. Use Image/Adjust/Brightness/Contrast to enhance images by dynamically changing
the lookup table mapping and Analyze/Show LUT to display the lookup table of the active image.

| File Menu | Contents
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File Menu
●

New...

●

Open...

●

Open Samples>

●

Import>

●

Close

●

Save

●

Save As

●

Revert

●

Page Setup...

●

Print...

●

Quit

New...
Creates a new image window or stack. A dialog box allows you to specify the image title, type,
dimensions and initial content.

Name is the title that will be used for the Window. Type is the image type: 8-bit grayscale, 16-bit
grayscale (unsigned), 32-bit (float) grayscale or RGB color. Fill With (White, Black, Ramp, or
Clipboard Contents) specifies how the image is initialized. Width and Height specify the image
dimensions in pixels. Width and Height are ignored if Fill With is set to Clipboard Contents. Set
Slices to a value greater than one to create a stack.
Top

Open...
Reads an image and displays it in a separate window. Files must be in TIFF (uncompressed), GIF,
JPEG, DICOM, BMP, PGM or FITS format. Also opens SalsaJ and NIH Image lookup tables (with7".lut"

extension). Additional file formats are supported via plugins installed in the Import submenu.
Example:
TIFF images can be 1-bit, 8-bits, 16-bits (unsigned), 32-bit (real) or RGB color. File must be
uncompressed.
FITS (Flexible Image Transport System) image is the format adopted by the astronomical
community for data interchange and archival storage. Use Image/Show Info to display the
FITS header. Information about FITS is available from http://fits.gsfc.nasa.gov.
Top

Import
This submenu lists the installed image acquisition plugins.

Image Sequence...
Opens a sequence of images in a folder as a stack. The images must all be the same
size and type. They can be in TIFF, JPEG, DICOM, BMP, GIF, FITS or PGM format.
There are two dialog boxes: one to select the folder and one to specify options. In the
first dialog, select one of the images in the folder and click "Open". Use the second
(shown below) to specify which images in the folder to open and/or to have the images
converted to 8-bits or reduced in size.

Use the Number of Images field to specify how many images to open. Set Starting
Image to n to start with the nth image in the folder. Set Increment to "2" to open
every other image, to "3" to read every third image, etc. Type a string into the File
Name Contains field and SalsaJ will only open files whose name contains that string.
Checking Convert to 8-bit Grayscale reduces memory requirements by 50% for 16-bit
images and by 75% for 32-bit and RGB images. Checking Open 1/2 Size reduces
memory requirements 75%. The size (widthxheightxdepth) of the stack that will be
created is displayed at the bottom on the dialog box.

LUT...
Opens an NIH Image lookup table, or a raw lookup table. The raw LUT file must be 768
bytes long and contain 256 reds, 256 blues and 256 greens. If no image is open, a
256x32 ramp image is created to display the LUT. Lookup tables with file names ending
in ".lut" can also be opened using File/Open.

Text Image...
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Opens a tab-delimited text file as a 32-bit real image. The image's width and height
are determined by scanning the file and counting the number of words and lines. Use
Image/Lookup Tables/Invert LUT to correctly display text files imported from NIH
Image. For text files with integer values no larger than 255, use Image/Type/8-bits to
convert to 8-bits. Before converting, disable "Scale When Converting" in Edit/Options/
Miscellaneous to prevent the image from being scaled to 0-255.

Text File...
Opens a text file. Right click (command-click on the Mac) in a text window to activate a
pop-up menu with Save As, Cut, Copy, Paste and Select All commands. Most text files
can also be opened using File/Open.

URL...
Downloads and displays a TIFF, JPEG, DICOM, BMP, GIF or FITSimage specified by a
URL. Here are some example URLs: http://fhou.cicrp.jussieu.fr/IkeyaZhang_sm.jpg

Raw...
Use this command to import images that are not in a file format directly supported by
SalsaJ. You will need to know certain information about the layout of the image file,
including the size of the image, and the offset to the beginning of the image data.
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Use the pop-up menu at the top of the dialog box to specify the image type. There are
nine choices:
●

8-bit unsigned integer

●

16-bit signed integer (converted to unsigned by adding 32,768)

●

16-bit unsigned integer

●

32-bit signed integer (converted to float)

●

32-bit floating-point

●

24-bit RGB color (interleaved)

●

24-bit RGB color (planar)

●

32-bit ARGB color

●

1-bit Bitmap (converted to 8-bit)

Interleaved RGB images have pixels stored contiguously (rgbrgbrgb...) in a single
image plane. Planar RGB images have the red, green and blue image data stored in
separate 8-bit sample planes. SalsaJ saves RGB images (both TIFF and raw) in
interleaved format.
Image Width is the number of pixel in each row of image data and Image Height is the
number of rows in the image. Offset to First Image is the number of bytes in the file
before the first byte of image data.
Number of Images is the number of images stored in the file. If this value is greater
than the actual number of images the resulting stack will get truncated to the actual
size.
Gap Between Images is the number of bytes from the end of one image to the
beginning of the next. Set this value to width x height x bytes-per-pixel x n to skip n
images for each image read.
Check Black is Zero if black pixels are represented using numbers that are less than
the numbers used for white pixels. If your images look like photographic negatives,
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changing this field should fix the problem.
Little Endian Byte Order will probably need to be checked when importing 16-bit or 32bit grayscale images from little-endian machines such as Intel based PCs.
Check Open All and SalsaJ will import all the images in the folder as a stack. The
images must all be the same size and type.
Top

Close
Closes the currently active image window. If the image has changed, you will be asked if you want
to save the changes.
Top

Save
Saves the active image or stack. To save only a selected area, create a rectangular selection and
use the Image/Duplicate command.
Top

Save As
Use this submenu to save the active image in TIFF, JPEG, GIF or FITS, or "raw" format. Can also be
used to save measurement results, lookup tables, selections, and selection XY coordinates.

FITS...
Saves the active image in FITS format. The header information is created with informations
of the original image.

Tiff...
Saves the active image or stack in TIFF format. TIFF is the only format (other than
"raw") that supports all SalsaJ data types and the only format that saves spatial and
density calibration.

Gif...
Saves the active image in GIFformat. The image must be 8-bits in depth. If it's not,
convert it to 8-bit color using Image/Type/8-bit Color or to 8-bit grayscale using Image/
Type/8-bit.

Jpeg...
Saves the active image in JPEG format. Use Edit/Options/JPEG Quality to specify the
JPEG compression level (0-100). Lower values produce smaller files but poorer quality.
Larger values produce larger files but better quality. Warning: the JPEG format uses
lossy compression that can result in artefacts. This format should not be used if you
plan to make measurements on the image or to do further processing.

ZIP...
Saves the active image or stack as a TIFF file inside a compressed ZIP archive.

Raw Data...
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Saves the active image or stack as raw pixel data without a header. 16-bit images are
saved as unsigned shorts. 16-bit and float images are saved using big-endian byte
order.

Text Image...
Saves the active image as a spreadsheet compatible tab-delimited text file. For
calibrated images and floating-point images, the "Decimal Places" field in Analyze/Set
Measurements determines the number of digits to the right of the decimal point. For
RGB images, each pixel is converted to grayscale using the formula gray=0.299red
+0.587green+0.114blue or the formula gray=(red+green+blue)/3 if "Unweighted RGB
to Grayscale Conversion" is checked in Edit/Options/Conversions )

Image Sequence...
Saves all the slices in the active stack as separate TIFF, JPEG, GIF or raw files.

AVI...
Saves the active stack as an uncompressed AVI file. Windows users can use VirtualDub
to open uncompressed AVI files and resave as a compressed AVI. Macintosh users can
use the QuickTime Movie Player program to open uncompressed AVI files and, with the
Pro version, resave in compressed QuickTime format.

LUT...
Saves the active image's lookup table to a file. The 768 byte file consists of 256 red
values, 256 green values and 256 blue values.

Measurements...
Exports the contents of the "Results" window as a tab-delimited text file.

Selection...
Saves the current area selection boundary to a file. Use File/Open to restore the
selection.

XY Coordinates...
Exports the XY coordinates of the line selection or area selection boundary as a two
column, tab-delimited text file. Coordinates of rectangular, oval and straight line
selections can not be exported. Use the Path Writer plugin plugin to save coordinates
at evenly spaced one pixel intervals.
Top

Revert
Replaces the active image with the last saved version. This is a shortcut for closing the window
without saving, and then reopening it. The command currently does not work with stacks.
Top

Page Setup...
The Page Setup dialog allows you to control the size of printed output, plus other printing options.
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Scale values less than 100% reduce the size of printed images and values greater than 100%
increase the size. 100% corresponds to 72 pixels per inch, about the unzoomed screen size of the
image. The size of the printed image is determined by the Scale value and the width and height of
the image in pixels. Spatial calibration is ignored.
Check Draw Border to have SalsaJ print a one pixel wide black border around the image. Check
Center on Page and the image will be printed in the center of the page instead of in the upper left
corner. Check Print Title to have the title of the image printed at the top of the page.
Top

Print...
Prints the active image. The size of the printed image will normally be slightly less its size on the
screen (unzoomed). Use the Page Setup dialog to increase of decrease the size of printed images.
Images larger than the page are scaled to fit.
Top

Quit
Exits SalsaJ. If you have not saved any images, you will be prompted to do so. You can also exit by
clicking on the close button in the SalsaJ window's title bar.
Top
| Edit Menu | Contents
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Edit Menu
●

Undo

●

Cut

●

Copy

●

Paste

●

Paste Control...

●

Clear

●

Clear Outside

●

Selection>

●

Fill

●

Draw

●

Invert

●

Options>

●

Repeat Command

Undo
Reverses the effect of the most recent image editing or filtering operation. Note that operations on entire
stacks cannot be reversed using Undo.
Top

Cut
Copies the contents of the current image selection to the internal clipboard and fills it with the current
background color.
Top

Copy
Copies the contents of the current image selection to the internal clipboard. If there is no selection, copies the
entire active image. The amount of image data copied is shown in the status bar. Cut, Copy and Paste of
images to other applications is currently not supported. Select the Fill With Clipboard option in the File/New
dialog to create a new window from the contents of SalsaJ's internal clipboard.
Top

Paste
Inserts the contents of the internal clipboard into the active image. The pasted image is automatically selected,
allowing it to be dragged with the mouse. Click outside the selection to terminate the paste. Select Edit/Undo
to abort the paste operation.
Top

Paste Control...
After a Paste, use the Paste Control popup menu to control how the image currently being pasted is

14

transferred to the destination image.

Except for "Blend" and "Transparent", the Paste Control transfer modes are the same as those listed in the
description of Process/Image Calculator. The "Blend" mode is the same the Image Calculator "Average" mode.
In "Transparent" mode, white pixels are transparent and all other pixels are copied unchanged. "Transparent"
mode only works with 8-bits and RGB images.
Top

Clear
Erases the contents of the selection to the current background color (normally white). The backspace (or
delete) key is a handy shortcut for this command. Alt-click in the Image/Colors window to change the
background color.
Top

Clear Outside
Erases the area outside the current image selection to the background color. Alt-click in the Image/Colors
window to change the background color.
Top

Fill
Fills the current selection with the current foreground color. The foreground color is set by using the dropper
tool to "pick up" a new color from an image. Alt-click with any other tool, except the magnifying glass, to
temporarily switch to the dropper tool. Colors can be "picked up" from the Image/Colors window using any
tool. The dropper tool icon in the tool bar is drawn in the foreground color and the frame around it is drawn in
the background color.
Top

Draw
Outlines the current selection using the current foreground color and line width. The "Colors" window, opened
with the Image/Colors command, provides a palette of drawing colors. Colors can be "picked" up from the
"Colors" window without having to switch to the dropper tool. Use the Edit/Options/Line Width command, or
double-click on the freeline tool, to change the line width.
Top

Invert
Creates a reversed image, similar to a photographic negative, of the entire image or selection.
15

Top

Selection
The commands in this submenu create, delete or modify selections.

Select All
Creates a rectangular selection that is the same size as the image.

Select None
Deactivates the selection in the active image.

Restore Selection
Restores the previous selection to its original position. A selection is saved when you:
●

Delete the selection by clicking outside of it

●

Draw a new selection

●

De-activate the image containing the selection

●

Close the image containing the selection

●

Open a new selection using File/New

●

Use a command that deletes or modifies the selection

You can transfer a selection from one image to another by activating the image with the
selection, activating the destination image, then pressing shift-e (the keyboard shortcut for
Restore Selection).

Fit Spline
Fits a cubic spline curve to a polygon or polyline selection.
Top

Options
Use commands in this submenu to change various SalsaJ user preference settings.

Line Width...
Displays a dialog box that allows the width of lines generated by the Draw command to be
changed.
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JPEG Quality...
Use this dialog to specify the compression level use by the File/Save As/Jpeg command.
Requesting a higher degree of compression (a lower value) will produce smaller files, but poorer
image quality.

Fonts...
Opens a small window with three popup menus for specifying the type face, size and style of the
font used by the text tool.

Profile Plot Options...
Use this dialog to control how plots generated by Analyze/Plot Profile are displayed.

Plot Width and Plot Height specify the size of the plot in pixels. If Fixed Y-axis Scale is checked,
the y-axis range is fixed and the specified Y Min and Y Max values are used, otherwise, plots are
scaled based on the minimum and maximum gray values. Check Do Not Save X-Values to have
"List", "Save" and "Copy" in profile plot windows display or save only y-values. Check Auto-close
to have profile plot windows automatically closed when "List", "Save" or "Copy" are clicked on.
Check Vertical Profile to generate row average plots of rectangular areas instead of the default
column average plots.

Miscellaneous...
Displays a dialog box containing miscellaneous options.
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The Divide by Zero Value specifies the value used when Process/Image Calculator detects a divide
by zero while dividing one 32-bit real image by another. The default is infinity. In addition to
numeric values, "infinity" (positive or negative infinity), "max" (largest positive value) and
"NaN" (Not-a-Number) can be entered as the Divide by Zero Value value.
Check Use Pointer Cursor and SalsaJ will use an arrow cursor instead of the default crosshair that
is sometimes difficult to see on grayscale images in areas of medium brightness. This option can
also be used to work around a bug on Windows where the text cursor is sometimes used in place
of the crosshair. Note that SalsaJ must be restarted when running v1.33l and earlier.
Check Hide "Process Stack?" Dialog to suppress the dialog that asks "Process all xx slices?" (only
the current slice will be processed).
Check Antialiased Text to have the text tool create smoothed text and for the text displayed in
histogram windows and plot windows to be smoothed. Requires Java 1.2 or later.
Check Open/Save Using JFileChooser to enable versions of File/Open and File/Save As/ that use
the Java JFileChooser instead of the native OS file open and save dialogs. The main advantage of
JFileChooser is the ability to open multiple files by shift-clicking to select multiple contiguous files
and control-clicking to select more than one individual file. On the other hand, it is slower, uses
more memory, and does not behave like the file open and save dialogs used in other applications.
Check Debug Mode to enable display of debugging messages in the "Log" window. Close the "Log"
window to disable display of debugging messages.
Top

Repeat Command
Repeat the last command.
Top
| Image Menu | Contents |
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Image Menu
●

Type>

●

Adjust>

●

Show Info...

●

Color>

●

Stacks>

●

Crop>

●

Duplicate...

●

Scale...

●

Lookup Tables>

●

Show LUT>

●

Invert LUT>

Type>
Use this submenu to determine the type of the active image or to convert it to another type. For more informations about the types of bitmap
image, consult this link.

8-bit
Converts to 8-bit grayscale. The active image must be 16-bit grayscale, 32-bit grayscale, 8-bit color or RGB color.
SalsaJ converts 16-bit and 32-bit images to 8-bits by linearly scaling from min-max to 0-255, where min and max are the two values
displayed in the Image/Adjust/Brightness/Contrast tool. Image/Show Info displays these two values as the "Display range". Note that
this scaling is not done if "Scale When Converting" is not checked in Edit/Options/Miscellaneous. With stacks, all the slices are scaled
to 8-bits using the min and max of the currently displayed slice.
RGB images are converted to grayscale using the formula gray=0.299red+0.587green+0.114blue or the formula gray=(red+green
+blue)/3 if "Unweighted RGB to Grayscale Conversion" is checked in Edit/Options/Conversions.

16-bit
Converts to unsigned 16-bit grayscale. The active image must be 8-bit grayscale or 32-bit grayscale.

32-bit
Converts to signed 32-bit floating-point grayscale. The active image must be 8-bit grayscale or 16-bit grayscale.

8-bit Color
Converts to 8-bit indexed color using Heckbert's median-cut color quantization algorithm. A dialog box allows the number of colors (2256) to be specified. The active image must be RGB color.

RGB Color
Converts to 32-bit RGB color. The active image must be grayscale, 8-bit Color, or an RGB (red, green, blue) or HSB (hue, saturation
and brightness) stack.

RGB Stack
Converts to a 3-slice (red, green, blue) stack. The active image must be RGB color.

HSB Stack
Converts to a 3-slice (hue, saturation and brightness) stack. The active image must be RGB color.
An attempt to perform an unsupported conversion causes a dialog box to be displayed that lists the possible conversions. The * indicates that both
single images and stacks can be converted.
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Top

Adjust>
This submenu contains commands that adjust brightness/contrast, threshold levels and image size.

Brightness/Contrast...
Use this tool to interactively alter the brightness and contrast of the active image. With 8-bit images, brightness and contrast are
changed by updating the image's look-up table (LUT), so pixel values are unchanged. With 16-bit and 32-bit images, the display is
updated by changing the mapping from pixel values to 8-bit display values, so pixel pixel values are also unchanged. Brightness and
contrast of RGB images are changed by modifying the pixel values. (For more informations about the types of bitmap image, consult
this link)
Press shift-c to open the B&C window the quick and easy way. If it is already open, it is activated.

The line graph at the top of the window, which us superimposed on the image's histogram, shows how pixel values are mapped to 8bit (0-255) display values. The two numbers under the plot are the minimum and maximum displayed pixel values. These two values
define the display range, or "window". SalsaJ displays images by linearly mapping pixel values in the display range to display values in
the range 0-255. Pixels with a value less than the minimum are displayed as black and those with a value greater than the maximum
are displayed as white.
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There are four sliders. Minimum and Maximum control the lower and upper limits of the display range. Brightness increases or

decreases image brightness by moving the display range. Contrast increases or decreases contrast by varying the width of the display
range. The narrower the display range, the higher the contrast.
Click on Auto, and SalsaJ will automatically optimizes brightness and contrast based on an analysis of the image's histogram. Create a
selection, and the entire image will be optimized based on an analysis of the selection. The optimization is done by allowing a small
percentage of pixels in the image to become saturated (displayed as black or white). Each additional click on Auto increases the
number of saturated pixels and thus the amount of optimization.
Click on Reset to restore the original brightness and contrast settings. The display range is set to the full pixel value range of the
image.
Click on Set to enter the minimum and maximum display range values in a dialog box. A setMinAndMax() macro call is generated if the
command recorder is running.

Click on Apply to apply the current display range mapping function to the pixel data. If there is a selection, only pixels within the
selection are modified. This option currently only works with 8-bit images and stacks and with RGB stacks. This is the only B&C option
that alters the pixel data of non-RGB images.

Threshold...
Use this tool to interactively set lower and upper threshold values, segmenting the image into features of interest and background.
Pixels with brightness values greater than or equal to the lower threshold and less than or equal to the upper threshold are displayed
in red (example 1 with the file "Elephant.fits") . If Over/Under is selected in the popup menu, pixels with brightness values greater
than or equal to the upper threshold and less than or equal to the lower threshold are displayed in green(example 3).If Use Analyze/
Measure (with "Limit to Threshold" in Analyze/Set Measurements checked) to measure the aggregate of the selected features. Use
Analyze/Analyze Particles to measure features individually. Use the wand tool to outline a single featurepixels with brightness values
greater than or equal to the upper threshold and less than or equal to the lower threshold are displayed in green.
example 1 :

example 2 :

example 3 :
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Use the upper slider to adjust the minimum threshold value and the lower one to adjust the maximum. Hold the alt key down while
adjusting the minimum to move a fixed-width thresholding window across the range of gray values.
The Auto button automatically sets the threshold levels based on an analysis of the histogram of the current image or selection. Apply
sets thresholded pixels to black and all other pixels to white. Reset disables thresholding and update the histogram. B&W switches to a
mode where features are displayed in black and background in white (example 2). Click on Set (not shown) to enter new threshold
levels into a dialog box.

Size...
Scales the active image or selection to a specified width and height in pixels.

Check Constrain Aspect Ratio to create an image with the specified width and have SalsaJ adjust the height to maintain the original
aspect ratio. Check Interpolate to use bilinear interpolation. Set New width to 0 to create an image with the specified height and have
SalsaJ adjust the width to maintain the original aspect ratio.
Top

Show Info...
Opens a text window containing information about the active image. For DICOM and FITS images, also displays file header information. Use the
popup menu (right-click in the Info window) to save the information to a text file or copy it to the system clipboard.
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Top

Color>
Convert Stack to RGB
Converts a 2 or 3-slice stack to an RGB image. The stack must be 8-bit or 16-bit grayscale.

RGB Split
Separate an RGB image into 3 images in 8-bit or 16-bit grayscale.

RGB Merge....
Merge 3 images to an RGB image. The images must be 8bit or 16-bit grayscale. In fact, it's an opposite tool of RGB Split.
Opens a small window with three popup menus for specifying the 3 images.

Top

Stacks>
This submenu contains commands that work with stacks.

23

Add Slice
Inserts a blank slice after the currently displayed slice. Hold down the alt key to add the slice before the current slice.

Delete Slice
Deletes the currently displayed slice.

Next Slice
Displays the slice that follows the currently displayed slice. As a shortcut, press the ">" key.

Previous Slice
Displays the slice that precedes the currently displayed slice. As a shortcut, press the "<" key.

Set Slice...
Displays a specified slice. The user must enter a slice number greater than or equal to one and less than or equal to the number of
slices in the stack.

Convert Images to Stack
Creates a new stack consisting of all images currently displayed in separate windows. The images must all be the same type and size.
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Convert Stack to Images
Converts the slices in the current stack to separate image windows.

Make Montage
Produces a single image which contains the images from a stack displayed in a grid format. This can be useful for visual comparisons
of a series of images stored in a stack. A dialog box allows you to specify the magnification level at which the images are copied, and
to select the layout of the resulting grid.

Start Animation
Animates the active stack by repeatedly displaying its slices (frames) in sequence. Use Stop Animation, or click with the mouse, to
stop. Use the Animation Options dialog box to specify the animation speed. More than one stack can be animated at a time. As a
shortcut, press the "=" key to start animation.
Show Animation

Stop Animation
Terminates animation of the active stack.

Animation Options...
Use this dialog to set the animation speed in frames per second or to enable "oscillating" animation.
Top

Crop
Crops the image or stack based on the current rectangular selection.
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Top

Duplicate
Creates a new window containing a copy of the active image or rectangular selection. Hold the alt key down to skip the dialog box.

Top

Scale...
Resizes the image or selection horizontally and/or vertically by scale factors entered into a dialog box. Check Interpolate to scale using bilinear
interpolation. Use integer scale factors (2, 3, 5, etc.) for the best looking results, particularly with graphics and text. With scale factors less then
1.0, smoothing the source image prior to scaling may produce better looking results.

Top

Lookup Tables>
This submenu contains a selection of color lookup tables that can be applied to grayscale images to produce false-color images. More than 100
additional lookup tables are available at rsb.info.nih.gov/ij/download/luts/.
For example :

init

"LUT Green"

"LUT Spectrum"

"LUT Blue"

"LUT Red"

Top

Show LUT
Displays a plot of the active image's lookup table. The lookup table, or color table, describes the color that is displayed for each of the 256
possible pixel values. For 16 and 32 bit images, the range of displayed pixel values is mapped to 0-255. Note that RGB color images do not
use a lookup table.
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Top

Invert LUT
Inverts the current lookup table. For 8-bit images, the value (v) of each entry in the table is replaced by 255-v. With inverted LUTs, pixels with a value
of zero are white and pixels with a value 255 are black. Unlike the Edit/Invert command, pixels values are not altered, only the way the image is displayed
on the screen.
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| Operations Menu | Contents
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Operations Menu
●

Image Calculator...

●

Single Image Operators>

●

Rotate>

●

Translation>

Image Calculator...
Performs arithmetic and logical operations between two images selected from
popup menus. Image1 or both the Image1 and Image2 can be stacks. If both
are stacks, they must have the same number of slices. Image1 and Image2
must be the same data type but do not have to be the same size.

You can select one of 8 operators from the Operation: popup menu. Check
Create New Window and a new image or stack will be created to hold the result.
Otherwise, the result of the operation replaces some or all of Image1. With 32bit (float) images, pixels resulting from division by zero are set to the largest
possible value (3.4e38). This value can be redefined in Edit/Options/
Miscellaneous/Divide by Zero Value.
AND

img1= img1 AND img2

OR

img1 = img1 OR img2

XOR

img1 = img1 XOR img2

Min

img1 = min(img1,img2)
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Max

img1 = max(img1,
img2)

Average

img1 = (img1+img2)/2

Difference

img1 = |img1-img2|

Copy

img1 = img2

Some examples with two images:

result with "AND":
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result with "OR":

result with "XOR":

result with "Difference":
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Top

Single Image Operators>
The commands in this submenu add (subtract, multiply, etc.) a constant to each
pixel in the active image or selection. When the result value overflows/
underflows the legal range of the image's data type, the value is reset to the
maximum/minimum value. With stacks, selections are ignored and the specified
operation is performed on all slices in the stack.

Add...
Adds a constant to the image. With 8-bit images, results greater
than 255 are set to 255. With 16-bit signed images, results greater
than 65,535 are set to 65,535.

Subtract...
Subtracts a constant from the image. With 8-bit and 16-bit images,
results less than 0 are set to 0.

Multiply...
Multiplies the image by the specified real constant. With 8-bit
images, results greater than 255 are set to 255. With 16-bit signed
images, results greater than 65,535 are set to 65,535.

Divide...
Divides the image by the specified real constant. Attempts to divide
by zero will be ignored.

AND...
Does a bitwise AND of the image and the specified binary constant.
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OR...
Does a bitwise OR of the image and the specified binary constant.

XOR...
Does a bitwise XOR of the image and the specified binary constant.

Min...
Pixels in the image with a value less than the specified constant are
replaced by the constant.

Max...
Pixels in the image with a value greater than the specified constant
are replaced by the constant.

Gamma...
Applies the function f(p) = (p/255)^gamma*255 to each pixel (p)
in the image or selection, where 0.1 <= gamma <= 5.0. For RGB
images, this function is applied to all three color channels. For 16bit images, the image min and max are used for scaling instead of
255.

Log...
For 8-bit images, applies the function f(p) = log(p) * 255/log(255)
to each pixel (p) in the image or selection. For RGB images, this
function is applied to all three color channels. For 16-bit images,
the image min and max are used for scaling instead of 255. For
float images, no scaling is done. To calculate log10 of the image,
multiply the result of this operation by 0.4343 (1/log(10).

Reciprocal
Generates the reciprocal of the active image or selection. Only
works with 32-bit float images.
Top

Rotate>
This submenu contains commands that rotate the active image or stack.
Here the original image :
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Flip Vertical
Turns the image or selection upside down.

Flip Horizontal
Replaces the image or selection with a mirror image of the original.
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Rotate 90 Degrees Right
Rotates the entire image or stack clockwise 90 degrees.

Rotate 90 Degrees Left
Rotates the entire image or stack counter-clockwise 90 degrees.

Arbitrarily...
Use this dialog to rotate the active image or selection clockwise the
specified number of degrees. Check Interpolate to use bilinear
interpolation.
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Top

Translation>
Translate the active image or stack.The values of translation on X and Y are
specified in the popup menus.

Top
| Analyze Menu | Contents
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Analyze Menu
●

Measure

●

Clear Results

●

Photometry

●

Clear Photometry Results

●

Photometry Settings

●

Set Scale...

●

Histogram

●

Plot Profile

●

Surface Plot...

●

Tools

●

❍

Save XY Coordinates...

❍

Curve Fitting...

❍

ROI Manager

❍

Calibration Bar

Calibrate...

Measure
Based on the selection type, calculates and displays either area statistics, line lengths and angles. Area statistics are calculated if there is no selection or if a subregion of
the image has been selected using one of the four tools
of the three line selection tools
Examples :

in the tool bar. Calculates line length and angle if a line selection has been created using one

.

To export the measurements as a tab-delimited text file, select File/Save As/Measurements from the SalsaJ menu bar or File/Save As from the "Results" window menu
bar. Copy the measurements to the clipboard by selecting Edit/Copy All from the "Results" window menu bar. You can also save measurements by right-clicking in the
Results window and selecting Save As or Copy All from the popup menu.
The width of the columns in the "Results" window can be adjusted by clicking on and dragging the vertical lines that separate the column headings.
Top

Clear Results
Erases the results table and resets the measurement counter.
Top

Photometry
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Photometry is the determination of the flux of light emitted by a star. It is calculated by correcting the integrated values of the pixels by the value of the sky

background. This value can be related to the star intensity selection is shown. Click once to select a subregion of the image where the photometry will be applied.
Example :

Top

Clear Photometry Results
Erase the results table and rests the measurement counter.
Top

Photometry Settings

Top

Set Scale...
Use this dialog to define the spatial scale of the active image so measurement results can be presented in calibrated units, such as millimeters. Before using this
command, use the straight line selection tool to make a line selection that corresponds to known distance. Then, bring up the Set Scale dialog, enter the known distance
and unit of measurement, then click OK. SalsaJ will have automatically filled in the Distance in Pixels field based on the length of the line selection.

Set Distance in Pixels to zero to revert to pixel measurements.
Setting Width/Height Ratio to a value other than 1.0 enables support for different horizontal and vertical spatial scales, for example 100 pixels/cm horizontally and 95
pixels/cm vertically. To set the pixel aspect ratio, measure the width and height (in pixels) of a digitized object with a known 1:1 aspect ratio. Enter the measured width
(in pixels) in Distance in Pixels. Enter the known width in Known Distance. Then calculate the aspect ratio by dividing the width by the height and enter it in Pixel Aspect
Ratio.
When Global is checked, the scale defined in this dialog is used for all images instead of just the active image.
Two examples of how to use the Set Scale command are available:

Area Measurements (PDF) and DNA Contour Length Measurement.
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Top

Histogram
Calculates and displays a histogram of the distribution of gray values in the active image or selection. The x-axis represents the possible gray values and the y-axis
shows the number of pixels found for each gray value. The total pixel count is also calculated and displayed, as well as the mean, modal, minimum and maximum gray
value.

Use the Save or Copy buttons to save the histogram data. Click on Log to display a log-scaled version of the histogram. The number to the right of Value:, which
changes as you move the cursor, is the grayscale value corresponding to the x-axis cursor position and Count: is the number of pixels that have that value.
With RGB images, the histogram is calculated by converting each pixel to grayscale using the formula gray=0.299red+0.587green+0.114blue or the formula gray=(red
+green+blue)/3 . With 16-bit images, the range of gray values between the Min and Max values is divided into 256 bins.

Top

Plot Profile
Displays a two-dimensional graph of the intensities of pixels along a line within the image. The x-axis represents distance along the line and the y-axis is the pixel
intensity.

Top

Surface Plot
Displays a three-dimensional graph of the intensities of pixels in a grayscale or pseudo color image. Creates a stack of plots when the source is a stack. Some plots can
be improved by adjusting the contrast of the source image or smoothing it. When plotting a stack, closing the plot stack window will abort the plotting process.
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Change the Number of samples to adjust the number of profiles used to generate the plot. Check Draw Wireframe to have the outline each profile drawn in black. Check
Shade to generate a shaded plot. The plot will be in color if the source image uses a color LUT. Check Draw Axis to have the three axis drawn and labeled. If Source
Background is Lighter is checked, lighter areas in the source image represent lower elevations (valleys) while darker areas in the source image represent higher
elevations (peaks). If Fill Plot Background with Black is checked, the plot is drawn with a black background.

Top

Tools
This submenu provides access to various image analysis plugins.

Save XY Coordinates...
Writes to a text file the XY coordinates and pixel value of all non-background pixels in the active image. For grayscale images, writes three values per line
(x, y, and value), separated by spaces. For RGB images, writes five values per line (x, y, red, green and blue).

Curve Fitting...
Construct and display in a new window the interpolate curve of points with a text file who contains these XY coordinates.
Examples :
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ROI Manager
The ROI (Region of Interest) Manager is a tool for working with multiple area selections.
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Click Add to add the current ROI to the list. Click Delete to delete the selected ROIs from the list. Click Open to open an ROI file and add it to the list. Click
Open All to open all the ROI files in a folder and add them to the list. Click Save to save the selected ROIs as files. Click Measure to measure the selected
ROIs. With a stack, a dialog box allows the user to choose between measuring all of the images in the stack or only the current slice. Click Draw to draw
outlines of the selected ROIs using the current foreground color and line width. Click Fill to fill the selected ROIs with the current foreground color. Click in
the Image/Colors window to set the foreground color. Use Edit/Options/Line Width to set the line width.
Scale Bar...
Display a scale bar on the image. This bar show the width in pixels.

Calibration Bar
Creates an RGB copy of the current image and displays a labeled calibration bar on it.

Change Location to move the calibration bar. If there is a selection, the bar is initially drawn at the selection. Change Fill Color to adjust the bar's
background color. Change Label Color to adjust the text color. Change Number of Labels to adjust the total number of values displayed. Change Decimal
Places to adjust the number of decimal places present in the labels. Change Font Size to adjust the labels' font size. Change Zoom Factor to scale the entire
calibration bar. If Bold Text is checked, labels are drawn bold.
Top

Calibrate...
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Use this dialog box to calibrate an image to a set of density standards, for example radioactive isotope standards or a calibrated optical density step tablet. Before using
this command, use Analyze/Clear Results to reset the measurement counter and use one of the selection tools and Analyze/Measure to record the mean gray value of

each of the standards. There is an example that shows how to calibrate to an optical density step tablet.
When finished making the measurements, select Analyze/Calibrate to display the Calibrate dialog box. To calibrate the image, enter the known standard values in the
right column, select a curve fitting method from the popup menu, enter the unit of measurement, and click OK. SalsaJ will then display the calibration function.

If the calibration function is not satisfactory, bring up the Calibrate dialog box again and select a different curve fitting method.
Rodbard is a four parameter general curve fit function proposed by David Rodbard at NIH. The form of the equation is:
y = d + (a - d) / (1 + (x/c)^b)
Selecting Uncalibrated OD from the popup menu causes SalsaJ to convert gray values to uncalibrated optical density values using the function
Uncalibrated OD = log10(255 / PixelValue)
You do not need to measure OD standards or enter known OD values to enable this feature.
Top
|Plugins Menu | Contents |
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Plugins Menu
●

Introduction

●

Macros>

●

Shortcuts>

●

Utilities>

●

New...

●

Edit...

●

Compile and Run...

Introduction
Plugins and macros are loadable code modules that extend the capabilities of
SalsaJ. Plugins are written in the Java programming language and compiled to .
class files. Macros, written in SalsaJ's Java-like macro language, are stored in .
txt files. Plugins run faster and are more flexible but macros are easier to write
and debug. Plugins and macros in the plugins folder, with an underscore in their
name, are listed at the bottom of this menu. Plugins and macros in subfolders of
the plugins folder are listed in submenus. Use Shortcuts/Create Shortcut to
assign a keyboard shortcut to a plugin or a macro.
Use the Record command to record a series of commands and to convert them
to a macro. Use the New command to create a new macro or plugin and Edit to
make changes to an existing one. More than 100 plugins are available on the
ImageJ Web site as well as more than 80 macros. A tutorial for plugin writers is
available at http://mtd.fh-hagenberg.at/depot/imaging/imagej/. Information
about macros is available on the ImageJ Web site.

Internal Plugins
Most commands in SalsaJ are implemented as plugins but these internal plugins
are located in the salsaj.jar file, not in the plugins folder. salsaj.jar also contains
the properties file (IJ_Props.txt) that SalsaJ uses to install internal plugins in
menus. A JAR file (Java ARchive) is formatted the same as a ZIP file, so you can
use a ZIP utility to look at the contents of salsaj.jar.
You can convert an internal plugin to a user plugin by copying the source to the
plugins folder, adding an underscore to the file name and class name, and
changing the package statement to an import statement. For example, to
change the RoiManager (Analyze/Tools/ROI Manager) to a user plugin:
1. Copy ij/plugin/frame/RoiManager.java to the plugins folder.
2. Change the file name to Roi_Manager.java.
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3. Open Roi_Manager.java using Plugins/Edit and change all instances (4) of
"RoiManager" to "Roi_Manager".
4. Change the first line from "package ij.plugin.frame;" to "import ij.plugin.
frame.*;".
5. Run the new plugin using the editor's File/Compile and Run command.
There will be a new Roi Manager command in the Plugins menu the next time
you restart SalsaJJ.

Changing Location of Plugins Directory
The "plugins.dir" property specifies the location of the parent of the plugins
directory. This property can be set from either the command line or from within
a Java program that starts SalsaJ. For example, if you run SalsaJ with the
command
java -Dplugins.dir=/Users/wayne -cp ij.jar ij.ImageJ
it will look for the plugins folder in the /Users/wayne/ directory. This property
can also be set in a program that launches SalsaJ:
System.getProperties().setProperty("plugins.dir", "/users/wayne");
new ImageJ(null);

Macros>
This submenu contains commands for installing, running and recording macros,
as well as any macro commands added by Plugins/Macros/Install. Macros
contained in a file named "StartupMacros.txt", in the macros folder, are
automatically added to this submenu when SalsaJ starts up.

Install...
Adds one or more macros contained in a file to the bottom of this
submenu. To install a set of macros, and at the same time view
their source code, open the macro file with File/Open and use the
editor's Macros/Install Macros command. Macros in the file ImageJ/
macros/StartupMacros.txt are automatically installed when SalsaJ
starts up.

Run...
Loads and runs a macro without opening it in the SalsaJ editor. To
run a macro, and at the same time view its source code, open it
with File/Open and use the editor's File/Run Macro command.

Record...
Opens the SalsaJ command recorder. To create a macro, open the
recorder, use one or more SalsaJ commands, then click "Create".
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When the recorder is open, each menu command you use
generates a macro run() function call. The run() function has one
or two string arguments. The first is the command name. The
optional second argument contains dialog box parameters.
Create a rectangular, oval or line selection and the recorder will
generate a makeRectangle(), makeOval() or makeLine() function
call. Click on "Auto" or "Set" in the Image/Adjust/Threshold window
to generate a setThresold() call, and on "Reset" to generate a
resetThresold() call. Select an image from the Window menu to
generate a selectWindow() call. Click in the Image/Color/Color
Picker window to generate setForegroundColor() and
setBackgroundColor() calls.

Shortcuts>
This submenu contains commands for creating keyboard shortcuts and for
installing and removing plugins.

Create Shortcut...
Assigns a keyboard shortcut to an SalsaJ menu command and lists
the shortcut in the Shortcuts submenu.

Select the command from the popup menu and enter the shortcut
in the text field. A shortcut can be a lower or uppercase letter or
"F1" through "F12". Use Plugins/Utilities/List Shortcuts to get a list
of shortcuts that are already being used.

Install Plugin...
Installs a plugin in a user-specified submenu. Plugins with a
showAbout() method are also automatically added to the Help/
About Plugins submenu.
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Use the first popup menu to select the plugin and the second to
select the submenu it is to installed in. The command must be
different from any existing SalsaJ command. Shortcut (optional)
must be a single letter or "F1" through "F12". Argument (optional)
is the string that will passed to the plugin's run method.

Remove...
Removes commands added to the Shortcuts submenu by Create
Shortcuts. Also removes commands added by Install Plugin and
removes plugins installed in the Plugins menu. The menus are not
updated until SalsaJ is restarted.

Utilites>

Control Panel...
This command opens a window containing SalsaJ commands in a
hierarchical tree structure. Click on a leaf node to launch the
corresponding SalsaJ command (or plugin). Double-click on a tree
branch node (folder) to expand or collapse it. Click and drag on a
tree branch node (folder) to display its descendants in a separate
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(child) window. In a child window, click on "Show Parent"to reopen the parent window. The Control Panel was contributed to the
imageJ project by Cezar M. Tigaret.

Monitor Memory...
Displays a continuously updated graph of SalsajJ's memory
utilization, which can be useful for detecting memory leaks. Ideally
you should be able to open a several images, process them, close
them, and the amount of memory used will be the same as when
you started. Clicking on SalsaJ's status bar, which forces the Java
garbage collector run, may help reclaim unused memory. Start the
memory monitor with the alt key down to have it use a 640x480
window that simulates how a frame grabber plugin would work.

Capture Screen
Copies the the screen to an RGB image and displays that image a
new window. Pressing control-shift-g will capture the screen while
a modal dialog box is active if the dialog is based on SalsaJ's
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GenericDialog class.

New...
Opens a new text window containing a prototype (as Java source code) for one
of the three types of plugins supported by SalsaJ.
PlugIn: Opens, captures or generates images. Implements the
PlugIn interface. The prototype displays "Hello world!" in the SalsaJ
window. Another example is the Step Maker plugin at http://rsb.
info.nih.gov/ij/plugins/steps.html.
PlugInFilter: Processes the active image. Implements the
PlugInFilter interface. The prototype inverts the active image twice.
Another example is the Image Inverter plugin at http://rsb.info.nih.
gov/ij/plugins/inverter.html.
PlugInFrame: Displays a nonimage window containing controls
such as buttons and sliders. Extends the PlugInFrame class. The
prototype opens a window containing a text area. Another example
is the IP Demo plugin at http://rsb.info.nih.gov/ij/plugins/ip-demo.
html.
The text window created by this command has two menus: File and Edit. Use
Compile and Run in the File menu to compile and run the plugin. The Edit menu
does not contain Cut/Copy/Paste but the keyboard shortcuts for these function
can be used. Note that the name you choose for the plugin must include at least
one underscore.

Edit...
Opens a text window that allows you to edit, compile and run plugins. Like the
the Compile and Run command, it requires that SalsaJ be running on a Java
Virtual Machine that includes the javac compiler.

Compile and Run...
Compiles and runs a plugin. Requires that SalsaJ be running on a Java Virtual
Machine that includes the javac compiler. Javac is included with the Windows
and Linux versions of SalsaJ that come bundled with a Java runtime. It is also
included with Mac OS X Java. Users of Sun's Java 2 SDK (Software Development
Kit) for Windows, Linux and Solaris must add tools.jar to the command line that
runs SalsaJ.
Here is an example Windows command line for running SalsaJ using the Java 2
SDK (aka JDK):
49

java -mx100m -cp salsaj.jar;C:\jdk1.4\lib\tools.jar ij.ImageJ
It assumes the Java 2 SDK is installed in C:\jdk1.4. On a Unix system, the
command would look something like this:
java -mx100m -cp salsaj.jar:\usr\local\jdk1.4\lib\tools.jar ij.
ImageJ
The -mx100 options specifies that SalsaJ can use up to 100MB of RAM. To avoid
virtual memory thrashing, this value should not be set to more than 2/3 of
available RAM (e.g. -mx170m on a 256MB machine).
On Windows, you can create a double-clickable shortcut that uses Java 2 to run
SalsaJ:
1. Right-click on the desktop and select New->Shortcut from the menu
2. Enter
javaw -mx100m -cp salsaj.jar;C:\jdk1.4\lib\tools.jar ij.ImageJ
as the "Command line"; click "Next"
3. Enter a name for the shortcut (e.g. "SalsaJ"); click "Finish"
4. Right-click of the newly created shortcut and select Properties from the
menu
5. Click on the Shortcut tab
6. Enter the path to the SalsaJ folder (normally C:\SalsaJ) in "Start in"; click
"OK"
"javaw" is a variation of the java command that runs Java applications without a
DOS window.
| Window Menu | Contents |
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Window Menu
This menu contains two commands plus a list of open SalsaJ windows. The currently active
image will have a checkmark next to its name. To activate a window, pull down this menu
and select the window by name.

SalsaJ [enter]
Press the enter key to bring the SalsaJ window to the front.

Put Behind [tab]
Displays the next open image. Repeatedly press the tab key to cycle through all
open images.
| Help Menu | Contents |
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Help Menu
About Plugins>
This submenu displays information about plugins that have been developed for
use with SalsaJ. The Plugins/Hot Keys/Install Plugin command automatically
updates this submenu when a plugin with a ShowAbout method is installed.

SalsaJ Web Site...
Opens the EU-HOU Web site (http://www.euhou.net) in a browser window.

About SalsaJ...
Displays a dialog box containing information about SalsaJ.
| Contents|
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Installation
●

Linux x86

●

Mac OS X

●

Windows

| Contents |
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Linux x86 Installation
To install and run SalsaJ, download the Linux .tar.gz file, extract the SalsaJ directory,
change to the SalsaJ directory, and execute the 'salsaJ' script.
Here is an example:
tar -zxvf salsaJ_VO1-Linux-JDK.tgz
cd SalsaJ
./salsaJ
This installation includes Sun's Java Runtime Environment 1.5.

Memory
To make more than 512MB of memory available to SalsaJ, edit the 'SalsaJ' script. For
example, changing the script to
./jre/bin/java -Xmx256m -jar salsaj.jar
makes 256MB available to SalsaJ.

Upgrades
To upgrade to the latest version of SalsaJ, replace the salsaj.jar JAR file in the SalsaJ
directory with a newer one from .

Sharing SalsaJ and the JRE
You can specify the location of the plugins directory from the command line using the -D
option to set the "plugins.dir" property. This allows SalsaJ to be in a common location (e.
g., /usr/local/SalsaJ) and run from the users home directory using a shell script. This
example script runs SalsaJ from /usr/local/SalsaJ using a plugins directory at /home/
euhou/SalsaJ/plugins:
cd /usr/local/SalsaJ
./jre/bin/java -Xmx512m -jar salsaj.jar -Dplugins.dir=/home/euhou
This example uses the Java 1.5 SDK to run SalsaJ from /usr/local/SalsaJ with the plugin
directory also located in /usr/local/SalsaJ:
/usr/java/jdk1.5/bin/java -Dplugins.dir=/usr/local/ImageJ -Xmx512m
-jar /usr/local/SalsaJ/salsaj.jar:/usr/java/jdk1.5/lib/tools.jar

Compiling Plugins
The Plugins/Compile and Run command uses the javac compile contained in tools.jar. The
Java 1.5 runtime included with the Linux distribution of SalsaJ includes tools.jar in
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ImageJ/jre/lib/ext. Users of the Java SDK will need to add tools.jar to the command line.
Here is an example:
java -Xmx512m -jar salsaj.jar:\usr\local\jdk1.5\lib\tools.jar

| Install | Download | Contents |

55

OS X Installation
To install and run SalsaJ, download the Mac .tar.gz file, extract the SalsaJ directory,
change to the SalsaJ directory, and execute the 'salsaJ' script.
Here is an example:
tar -zxvf salsaJ_VO1-Mac.tgz
cd SalsaJ
./salsaJ
This installation not includes Sun's Java Runtime Environment 1.5.

Memory
To make more than 512MB of memory available to SalsaJ, edit the 'SalsaJ' script. For
example, changing the script to
./jre/bin/java -Xmx256m -jar salsaj.jar
makes 256MB available to SalsaJ.

Upgrades
To upgrade to the latest version of SalsaJ, replace the salsaj.jar JAR file in the SalsaJ
directory with a newer one from .

| Install | Download | Contents |
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Windows Installation
These notes apply to SalsaJ 1.0, which is distributed as a Windows installer. To install and run
SalsaJ, download the Windows .zip file, extract the SalsaJ directory, and launch the "Setup.exe".

Requirements
SalsaJ requires Windows 95 or later. It runs on a machine with 64MB but it runs better with
256MB or more, particularly when working with large images and/or stacks.

Memory
Use the Edit/Options/Memory command to make more than the default 128MB available to
SalsaJ. Note that setting the "Maximum Memory" value to more than about 75% of real RAM
may result in poor perfomance due to virtual memory "thrashing". The maximum amount of
memory that can be allocated is about 1.7 GB.

Upgrading
To upgrade to the latest version of SalsaJ, replace the salsaj.jar file in the SalsaJ folder with a
newer one from .

About the Installer
The SalsaJ Windows installer is created using the Inno Setup installer generator.

Adding a JAR File
Some plugins require adding a JAR file to SalsaJ. In SAlsaJ 1.0, this is done by copying the JAR
file into the plugins folder or an immediate subfolder of the plugins folder, then restarting SalsaJ.
To compile a plugin that uses a JAR file, copy the JAR file to the Java extensions folder, SalsaJ\jre
\lib\ext.

| Install | Download | Contents |
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Tools

File/New...
File/Open...
File/Save
File/Save As/Fits...
File/Print...
Edit/Clear
Edit/Undo
Image/Adjust/Brightness/Contrast...
Analyse/Photometry
Analyse/Photometry Settings
Analyse/Clear Photometry Results
Help/Online Docs...

Area Selection Tools
Use these tools to create area selections that will be operated on separately from the rest of the image. The
contents of an area selection can be copied to the internal clipboard, cleared (to white), filled with the current
drawing color, outlined (using Edit/Draw), filtered, or measured. Use the backspace key as a shortcut for Edit/Clear.
Use Image/Colors to set the drawing color. Double click on any line tool to change the line width used by Edit/Draw.
Use the arrow keys to "nudge" a selection one pixel at a time in any direction.

Rectangle
When creating the selection, drag with the shift key down to constrain it to a square. Use the small
"handle" in the lower right corner to resize. Use the arrow keys with the alt key held down to change
the width or height one pixel at a time. As a selection is created or resized, its location, width and
height are displayed in the status bar.

Oval
Creates an elliptical selection. Holding the alt key down forces the selection to be circular. Use the
arrow keys with the alt key pressed to change the width or height. As the selection is created or
resized, its width and height are displayed in the status bar.

Polygon
Creates irregularly shaped selections defined by a series of line segments. To create the selection, click
repeatedly with the mouse to create line segments. When finished, click in the small box at the starting
point (or double-click), and SalsaJ automatically draws the last segment.

Freehand
The freehand tool lets you create irregularly shaped selections by dragging with the mouse.

Wand Tool
Creates a selection by tracing objects of uniform color or thresholded objects. To trace an object,
either click inside near the right edge, or outside to the left of the object. To visualize what happens,
imagine a turtle that starts moving to the right from where you click looking for an edge. Once it finds
the edge, it follows it until it returns to the starting point. Note that the wand tool may not reliably 58
trace some objects, especially one pixel wide lines, unless they are thresholded (highlighted in red)

using the Image/Adjust/Threshold tool.

Line Selection Tools
Use these tools to create line selections. Use Analyze/Measure to calculate the length of a line selection. Use Edit/
Draw to permanently draw the line on the image. Change the drawing color by clicking in the Image/Colors window.
Double click on any line tool to specify the line width. Use the arrow keys to "nudge" a line selection one pixel at a
time.

Straight Line
Use this tool to create a straight line selection. Holding the alt key down forces the line to be horizontal
or vertical. To spatially calibrate an image, create a line selection corresponding to a known distance (e.
g. 10mm), then enter that distance in the Analyze/Set Scale dialog box. PlugIns/Draw Arrow will draw
an arrow based on a straight line selection.

Segmented Line
Create a segmented line selection by repeatedly clicking with the mouse. Each click will define a new
line segment. Double-click when finished.

Freehand Line
Select this tool and drag with the mouse to create a freehand line selection.

Angle
Create a angle selection by clicking Three times with the mouse. The two first create the first straight
line of the angle and the last create the second. The value of the angle is displayed during the
construction in the status bar.

Point Selection Tool
Use this tool to create a point selection and to display coordinates and value in a new window. Click once to create a
single point selection. Click to add more points. Alt-click on a point to delete it. Double-click on the point tool icon
to display the following configuration dialog box.

Text Tool
Use this tool to add text to images. It creates a rectangular selection containing one or more lines of text. Use the
keyboard to add characters to the text and the backspace key to delete characters. Use Edit/Draw to permanently
draw the text on the image. Use Edit/Options/Fonts, or double-click on the text tool, to specify the typeface, size
and style.

Magnifying Glass
Click on the image with this tool to zoom in. Alt-click (or right-click) to zoom out. The current magnification is
shown in the image's title bar. Double-click on the magnifying glass icon to revert to 100% (1:1) magnification.
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There are 20 possible magnification levels: 3.1, 4.2, 6.3, 8.3, 12.5, 16.7, 25, 33.3, 50, 75, 100, 200, 300, 400,

600, 800, 1200, 1600, 2400 and 3200 percent. When zooming in, press the shift key to prevent the window from
being enlarged.

Scrolling Tool
Allows you to scroll through an image that is larger than its window. When using other tools (except the text tool),
you can temporarily switch to this tool by holding down the space bar.

Color Picker
Sets the foreground drawing color by "picking up" colors from images. The color of this tool's icon changes to match
the drawing color. Colors can "picked up" from the Image/Colors window using any tool. Alt-click in the Image/
Colors window to change the background color. Double-click on this tool to display the Image/Colors window. he
icon for this tool is drawn in the current foreground color and the frame around it is drawn in the current
background color.
| Contents |
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Keyboard Shortcuts
Command

Shortcut

Description

New

N

Creates a new image or stack

Open

O

Opens a TIFF, GIF, JPEG, BMP, DICOM or FITS

Open Samples

Shift-B

Opens "Blobs" example image

Close

W

Closes the active window

Save

S

Saves active image in Tiff format

Revert

R

Revert to saved version of image

Print

P

Print active image

Undo

Z

Reverses the effect of the last operation

Cut

X

Copy image to clipboard and clear selection

Copy

C

Copy image to clipboard

Paste

V

Paste clipboard selection into active image

Clear

backspace

Erases selection to background color

Select All

A

Select entire image

Select None

Shift-A

Delete selection

Restore Selection

Shift-E

Restores ROI

Fill

F

Fills selection in foreground color

Draw

D

Draw selection

Invert

Shift-I

Invert image or selection

Adjust Contrast

Shift-C

Adjust brightness and contrast

Adjust Threshold

Shift-T

Adjust threshold levels

Show Info

I

Displays information about active image

Next Slice

>

Advance to next stack slice

Previous Slice

<

Backup up to previous stack slice

Start Animation

=

Starts/stops stack animation

Duplicate

Shift-D

Duplicates active image or selection
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Scale

E

Scale image or selection

Smooth

Shift-S

3x3 unweighted smoothing

Find Edges

Shift-F

Performs Sobel edge detection

Repeat
Command

Shift-R

Repeats previous command

Measure

M

Displays statistics about active image or
selection

Histogram

H

Displays a histogram of the active window or
selection

Plot Profile

K

Displays density profile plot of current selection

ImageJ

enter

Brings ImageJ window to front

Put Behind

tab

Switches to next image window

Alt Key Modifications
Image/Adjust/Threshold: Adjusting Min also adjusts Max
Image/Stacks/Add Slice: Insert before current slice
Image/Stacks/Next Slice: Skip nine slices
Image/Stacks/Previous Slice: Skip nine slices
Image/Duplicate: Don't show dialog
Image/Colors: Alt-click to "pick up" background color
Process/Equalize: Do classic histogram equalization
Process/Subtract Background: Show background image
Analyze/Plot Profile: For rectangular selections, generate row average plots
Analyze/Tools/Analyze Line Graph: Show intermediate image
Plugins/Utilities/ImageJ Properties: List all Java properties
Plugins/Utilities/Monitor Memory: Simulate 640x480 frame grabber
Any User Plugin: Load using new class loader

Space Bar Modifications
Any Tool: Temporarily switch to the "hand" (scrolling) tool
Moving through a stack: Automatically adjust min/max display values

Arrow Keys
Use the arrow keys to move selection outlines one pixel at a time. Resize
rectangular and oval selections by holding down the the alt (option) and while
using the arrow keys.
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bitmap image
●

Introduction

●

bitmap data

●

BMP fomat

●

GIF format

●

JPEG format

●

TIFF format

●

FITS format

Introduction
Graphic images that have been processed by a computer can usually be divided into
two distinct categories. Such images are either bitmap files or vector graphics. If you
work in image analysis, you need a good comprehension of the bitmap files. These
pages tries to describes bitmap data.

Bitmap data
Bitmaps images are exactly what their name says they are: a collection of bits
that form an image. The image consists of a matrix of individual dots (or pixels)
that all have their own colour (described using bits, the smallest possible units
of information for a computer).
Lets take a look at a typical bitmap image to demonstrate the principle:
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To the left you see an image and to the right a 250 percent enlargement of the
top of one of the mountains. As you can see the image consists of hundreds of
rows and columns of small elements that all have their own colour. One such
element is called a pixel -short for picture element). The human eye is not
capable of seeing each individual pixel so we perceive a picture with smooth
gradations.
The number of pixels you need to get a realistic looking image depends on the
way the image will be used.
Types of bitmap images
Bitmap images can contain any number of colours but we distinguish between
four main categories:
1. Line-art. These are images that only contain two colours, usually black
and white. Sometimes these images are referred to as bitmaps because a
computer has to use only 1 bit (on=black, off=white) to define each pixel.

2. Grayscale images, which contain various shades of grey as well as pure
black and white. Images can be 8-bits, 16-bits (unsigned) or 32-bits. i.e.
the precision shades of grey is described by the number of bits granted
for each Pixel.
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3. Multitones: such images contain shades of two or more colours. The most
popular multitone images are duotones, which usually consist of black
and a second spot colour (often an Pantone colour). The example below
contains black and Pantone Warm Red.

4. Full colour images. The colour information can be described using a
number of colour spaces: RGB (Red, Green , Blue). An RGB image,
sometimes referred to as a truecolor image, it defines red, green, and
blue color components for each individual pixel. RGB images do not use a
look up table. The color of each pixel is determined by the combination of
the red, green, and blue intensities stored in each color plane at the
pixel's location. Graphics file formats store RGB images as 24-bit images,
where the red, green, and blue components are 8 bits each. This yields a
potential of 16 million colors.

File formats that are used for bitmap data
Bitmap data can be saved in a wide variety of file formats. Among these are:
●

BMP: limited file format.

●

GIF: mainly used for internet graphics

65

●

JPEG: or rather the JFIF file format, which is mainly used for internet
graphics

●

TIFF: the most popular bitmap file format

●

FITS: the bitmap file format used in astronomy

BMP format
BMP is an acronym for Bimap, it is open format image developed by Microsoft
and IBM. It is the most simple image format.
BMP images can be 1-bits (Line-art), 4-bits (16 colors for a grayscale image or a
duotone image), 8 bits (256 colors for a grayscale image or a duotone image),
16-bits (65 536 colors for a grayscale image or a duotone image), ... or 24-bits
(RGB color with 8-bits for each primary color). The BMP format don't use
compression, they are generally a big files.

GIF format
GIF is an acronym for Graphics Interchange Forma. GIF is for pictures that use
256 (or fewer) distinct colors and animations that use 256 (or fewer) distinct
colors per frame. GIFs are compressed files, and are employed specifically to
reduce the amount of time it takes to transfer images over a network
connection.

JPEG format
JPEG is an acronym for Joint Photographic Experts Group. JPEGs are compressed
files. It is a format at loss, which thus eliminates from information, but one of
the strong points of JPEG is that its compression ratio is adjustable.This format
is useful to save results and not to analyze images.
In computing, JPEG is a commonly used standard method of lossy compression
for photographic images. The file format which employs this compression is
commonly also called JPEG; the most common file extensions for this format
are .jpeg, .jfif, .jpg, .JPG, or .JPE although .jpg is the most common on all
platforms. One of the strong points of JPEG is that its compression ratio is
adjustable.This format is especially useful to save results.

TIFF format
TIFF is a flexible and adaptable file format. It can handle multiple images and
data in a single file through the inclusion of "tags" in the file header. Tags can
indicate the basic geometry of the image, such as its size, or define how the
image data is arranged and whether variousimage compression options are used
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FITS format
FITS is an acronym for Flexible Image Transfer System and is the most
commonly used file format in astronomy.
FITS is often used to store also non-image data, such as spectra, photon lists,
data cubes, and much more. A FITS file may contain several extensions, and
each of these may contain a data object.
A major advantage of FITS for scientific data is that the header information is
human readable ASCII), so that an interested user can examine the headers to
investigate a file of unknown provenance. Each FITS file consists of one or more
headers containing ASCII card images (80 character fixed-length strings) that
carry keyword/value pairs, interleaved between data blocks. The keyword/value
pairs provide metadata such as size, origin, binary data format, free-form
comments, history of the data, and anything else the creator desires: while
many keywords are reserved for FITS use, the standard allows arbitrary use of
the rest of the name-space.
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